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BAB II 

TINJAUAN PUSTAKA 
 

2.1 Penelitian Terdahulu 

 Dalam melakukan penelitian ini, penulis membutuhkan rujukan pada 

penelitian terdahulu yang sebelumnya. Hal ini dimaksudkan untuk 

mengembangkan ide dan memperbaiki sistem sebelumnya. Terdapat 3 penelitian 

sebelumnya yang telah dilakukan guna menjadi refrensi bagi peneliti. 

 Pada tahun (2010 Muhammad Naufal Faris, Budi Prasetyo, dan Junarto 

Haloman) yang berjudul “ PERANCANGAN DAN REALISASI ALAT 

PEMANTAU TEKANAN ANGIN BAN MOBIL BERBASIS 

MIKROKONTROLER AVR ” Peneliti ini membahas Dalam Proyek Akhir ini 

direalisasikan alat pemantau tekanan ban mobil. Alat ini terdiri dari 2 bagian, yaitu 

bagian pengirim yang diletakkan pada ban mobil dan bagian penerima yang 

diletakkan pada dashboard mobil. Di bagian pengirim terdapat MPX5500 sebagai 

pneumatic sensor dengan range 0-72,5 psi, mikrokontroler AVR ATmega8 sebagai 

pengolah data, dan RF Transceiver YS-1020UA di fungsikan sebagai Transmitter. 

Sedangkan pada bagian penerima terdapat RF Transceiver YS-1020UA yang di 

fungsikan sebagai Receiver, mikrokontroler AVR ATmega8535 sebagai pengolah 

data, dan LCD sebagai display. Alat ini dapat digunakan untuk memantau tekanan 

angin pada ban mobil, memberikan informasi ke pengendara berupa nilai tekanan 

di LCD. Indikator LED warna hijau akan menyala jika tekanan ban antara 30-35 

psi, dan LED warna merah akan menyala jika tekanan ban kurang dari 30 psi atau 
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lebih dari 35 psi, sehingga dapat memberikan kenyamanan bagi pengendara dan 

meminimalisasi terjadinya hal-hal yang tidak diinginkan.[1]  

 Pada tahun (2018 Riki Aris Setiawan dan Dwi Marisa Midyanti) yang 

berjudul “ RANCANG BANGUN ALAT MONITORING TEKANAN ANGIN 

BAN SECARA REAL TIME MENGGUNAKAN METODE TSUKAMOTO 

PADA KENDARAAN RODA EMPAT ” Peneliti ini membahas Dalam penelitian 

ini direalisasikan alat monitoring tekanan angin ban secara real time menggunakan 

komponen utama sensor MPX 5700AP sebagai sensor tekanan angin ban dan sensor 

LM35 sebagai sensor suhu. Metode fuzzy Tsukamoto digunakan untuk 

pengambilan keputusan dalam menentukan kondisi ban kendaraan roda empat. Alat 

monitoring tekanan angin ban terdiri dari 4 modul sensor dan 1 modul penerima. 

Modul sensor berfungsi untuk mengirimkan data tekanan angin ban dan suhu udara 

yang dipasangkan pada masing-masing ban kendaraan. Pada modul penerima data 

yang dikirimkan oleh modul sensor ditampilkan pada LCD. Data dari modul sensor 

digunakan untuk perhitungan metode fuzzy Tsukamoto dengan indikator output 

berupa LED dan Buzzer sebagai penanda bahwa kondisi ban dalam keadaan 

rendah,baik atau tinggi. Tingkat keberhasilan metode fuzzy Tsukamoto dalam 

menentukan kondisi ban sebesar 85% dari 120 data berdasarkan hasil perbandingan 

data pada alat dan data kuesioner.[2] 

 Pada tahun (2017 Zulfadhly Azim, Mohamad Ramdhani, dan Mas Sarwoko) 

yang berjudul “ ALAT PENGUKUR TEKANAN UDARA PADA BAN 

KENDARAAN BERODA EMPAT BERBASIS ARDUINO UNO 

MENGGUNAKAN SENSOR MPX5500D ” pada penelitian ini membahas 
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mengenai pembacaan tekanan udara pada ban, kendaraan mampu menampilkan 

kepada pengendara kondisi ban kendaraan beroda empat, sehingga pada saat 

nantinya alat pengukur tekanan udara pada ban kendaraan beroda empat dapat 

mengatasi resiko kecelakaan dan dapat menghemat masa pakai ban kendaraan 

beroda empat. Dengan menggunakan suatu sensor MPX5500D sebagai alat 

pembaca tekanan udara, kemudian hasil dari pengukuran tekanan udara ban akan 

dikirim secara wireless communication menggunakan radio frequency 433MHz 

kepada microkonroller, yang selanjutnya akan di proses dan ditampilkan pada 

display LCD yang berada di dashboard pengemudi. Dengan terdapat metode 

penelitian dan langkah kerja alat tekanan udara serta teori pendukung yang sudah 

ada mengenai tentang tekanan udara yang diperoleh dari alat pendeteksi tekanan 

udara pada ban berbasis wireless communication dan sesuai dengan perancangan 

yang bertujuan untuk keamanan berkendara dan masa ban menjadi lebih lama.[3] 
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Tabel 1 2.1 Tabel Tinjauan Penelitian Terdahulu 

 
NO Judul Penulis Tahun Lembaga Hasil Penelitian Perbedaan 

1. RANCANG BANGUN ALAT 

MONITORING TEKANAN 

ANGIN BAN SECARA REAL 

TIME MENGGUNAKAN 

METODE TSUKAMOTO 

PADA KENDARAAN RODA 

EMPAT 

Riki Aris 

Setiawan dan 

Dwi Marisa 

Midyanti 

2018 FMIPA, Universitas 

Tanjungpura, 

Pontianak 

Menggunakan Arduino 

Uno R3, Arduino 

Mega2560, 

MPX5700AP,LM35, dan 

Metode Tsukamoto 

Menggunakan 

Wemos d1 mini 

buzzer dan 

aplikasi 

smartphone 

2. PERANCANGAN DAN 

REALISASI ALAT 

PEMANTAU TEKANAN 

ANGIN BAN MOBIL 

BERBASIS 

MIKROKONTROLER AVR 

Muhammad 

Naufal Faris, 

Budi 

Prasetya, dan 

Junarto 

Haloman 

2010 Teknik 

Telekomunikasi,FIT, 

Universitas Telkom 

Menggunakan Sensor 

Pneumatic, RF 

Transceiver, LCD, 

MPX5500  

Menggunakan 

Wemos d1 mini 

buzzer, 

MPX5700AP dan 

aplikasi 

smartphone 

3. ALAT PENGUKUR 

TEKANAN UDARA PADA 

BAN KENDARAAN 

BERODA EMPAT 

BERBASIS ARDUINO UNO 

MENGGUNAKAN SENSOR 

MPX5500D 

Zulfadhly 

Azim, 

Mohamad 

Ramdhani, 

Mas Sarwoko 

2017 Teknik Elektro, FTE, 

Universitas Telkom 

Menggunakan Sensor 

MPX5500D, Radio 

Frequency 433 MHz, LCD 

Menggunakan 

Wemos d1 mini 

buzzer, 

MPX5700AP dan 

aplikasi 

smartphone 
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2.2  Dasar Teori 

 Pada bagian sub bab pengerjaan laporan ini, penulis juga menggunakan dasar-

dasar tentang komponen yang akan digunakan pada rancang bangun alat pendeteksi 

tekanan udara pada ban kendaraan bermotor. Berikut ini adalah kajian teori yang 

akan di perlukan dalam menjalankan penelitian ini: 

2.2.1 Ban 

 Ban merupakan salah satu komponen penting dari kendaraan yang digunakan 

untuk mengurangi getaran yang disebabkan oleh ketidakteraturan permukaan jalan, 

melindungi roda dari aus dan kerusakan, serta memberikan kestabilan antara 

kendaraan dan tanah untuk meningkatkan percepatan dan mempermudah 

pergerakan. Ban pada dasarnya diklasifikasikan ke dalam dua struktur yakni 

struktur bias dan struktur radial. Perbedaan dari kedua tipe ban tersebut salah 

satunya terletak pada carcass. Carcass merupakan rangka ban yang keras dan cukup 

kuat yang berfungsi untuk menahan udara yang bertekanan tinggi, tetapi harus 

cukup fleksibel untuk meredam perubahan beban dan benturan.[2] 

2.2.2 Tekanan Ban 

 Tekanan ban adalah besarnya tekanan angin yang dikompres ke dalam ban. 

Ban merupakan bagian penting bagi kendaraan. Ketidak-sesuaian tekanan ban bisa 

berakibat fatal. Gambar dibawah memperlihatkan beberapa kondisi tekanan ban. 
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Gambar12.1 Kondisi Tekanan Ban 

 

(Under Inflation) menunjukkan suatu ban dengan kondisi tekanan angin ban yang 

kurang. (Over Inflation) menunjukkan suatu ban dengan kondisi tekanan angin ban 

tinggi. (Correct Inflation) menunjukkan suatu ban dengan kondisi tekanan ban 

standart. Setiap produsen kendaraan baik sepeda motor, mobil, bus, dan lain 

sebagainya pasti mempunyai rekomendasi tekanan ban yang standar. [4] 

 

2.2.3 IoT (Internet of Things) 

 Internet of Things (IoT) adalah sebuah konsep/skenario dimana suatu objek 

yang memiliki kemampuan untuk mentrasnfer data melalui jaringan tanpa 

memerlukan interaksi manusia ke komputer. IoT telah berkembang dari 

konvergensi teknologi nirkabel MEMS, dan “A Things” pada Internet of Things 

dapat didefinisikan sebagai subjek misalkan orang dengan monitor implant jantung, 

hewan peternakan dengan transponder biochip, sebuah mobil yang telah dilengkapi 

built-in sensor untuk memperingatkan pengemudi ketika tekanan ban rendah. 
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Sejauh ini IoT paling erat hubunganya dengan komunikasi machine-to-machine 

(M2M) di bidang manufaktur dan listrik, perminyakan, dan gas. Produk dibangun 

dengan kemampuan komunikasi M2M yang sering disebut dengan sistem cerdas 

atau “smart”. (contoh: smart label, smart meter, smart grid sensor). Meskipun 

konsep ini kurang populer hingga tahun 1999, namun IoT telah dikembangkan 

selama beberapa dekade. Alat internet pertama, misalnya adalah mesin Coke di 

Carneige Melon University di awal 1980-an. Para programer dapat terhubung ke 

mesin melalui internet, memeriksa status mesin dan menentukan apakah ada atau 

tidak minuman dingin yang menunggu mereka, tanpa harus pergi ke mesin tersebut. 

Istilah IoT (Internet of Things) mulai dikenal tahun 1999 yang saat itu disebutkan 

pertama kalinya dalam sebuah presentasi oleh Kevin Ashton, cofounder and 

executive director of the Auto-ID Center di MIT.[5] 

2.2.4 Wemos D1 Mini 

  Wemos merupakan  salah  satu  modul  board  yang dapat  berfungsi dengan  

arduino khususnya  untuk  project  yang mengusung  konsep IOT.  Wemos dapat 

running stand-alone tanpa perlu dihubungkan dengan mikrokontroler, berbeda 

dengan modul wifi lain yang masih membutuhkan mikrokontroler sebagai 

pengrontrol atau otak dari rangkaian tersebut,  wemos  dapat running  stand-alone 

karena didalamnya  sudah  terdapat  CPU yang dapat memprogram melalui serial 

port atau via OTA serta transfer program secara wireless.  

 Keunggulan wemos ada  beberapa  alasan  yang  menarik  untuk  disimak  

mengenai  keunggulan  wemos diantara lainnya modul wifi. 
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• Pinout yang compatible dengan arduino uno, wemos D1 

merupakan modul yang memiliki bentuk pinout standart seperti 

arduino.  

• Untuk  sekelas  modul  tambahan,  wemos  memiliki  frekuensi  

CPU yang  tinggi, karena  wemos  memiliki  processor  utama  32Bit  

dengan kecepatan 80MHz sehingga dapat mengeksekusi program lebih 

cepat dibandingkan mikrokontroleryang masih menggunakan 

ClockRate 8Bit. 

• Didukung  dengan  banyak  bahasa  pemograman,  selain  dapat  

dikontrol  dengan arduino  IDE,  wemos  juga  dapat  deprogram  dengan  

 bahasa  Python  dan  Lua. 

 Chipset Wemos memiliki 2 buah chipset yang digunakan sebagai otak kerja antara 

lainya. 

2.2.4.1 Chipset 

A.  Chipset ESP8266 

 ESP8266 merupakansebuah chip yang   memiliki   fitur   Wifi   dan 

mendukung    stack    TCP/IP.    Modul    kecil    ini    memungkinkan    sebuah 

mikrokontrolerterhubung kedalam jaringan Wifi dan membuat koneksi TCP/IP 

hanya  dengan  menggunakan commandyang  sederhana.  Dengan clock80  MHz 

chipini  dibekali  dengan  4MB eksternalRAM  serta  mendukung  format  IEEE 

802.11 b/g/n sehingga tidak menyebabkan gangguanbagi yang lain. 
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B. Chipset CH340 

 CH340   adalah chipset yang   mengubah   USB   serial   menjadi   serial 

interface,  contohnya  adalah  aplikasi converter  toIrDA  atau  aplikasi  USB 

converter  to  Printer.  Dalam  mode  serial interface,  CH340  mengirimkan  sinyal 

penghubung  yang  umum  digunakan  pada  modem.  CH340  digunakan  untuk 

mengubah perangkat serial interfaceumum untuk berhubungan dengan bus USB 

secara langsung. 

2.2.4.2 Pin Wemos 

 Dalam modul wemos terdapat pin digital dan analog: 

A. Pin Digital  

 Salah satu I/O port pada modul wemos dikenal dengan pin Digital. Pin ini 

dapat dikonfigurasikan baik sebagai inputan ataupun outputan. 

 

B. Pin Analog 

 Pin analog pada modul wemos ini memiliki 10 bit resolusi dengan nilai 

maksimal 3,2 Volt. Pin analog ini dapat digunakan persis dengan cara yang sama 

dengan digital.[6] 
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Gambar22.2 Wemos D1 Mini 

Spesifikasi dari Wemos D1 Mini 

• Beroperasi pada tegangan operasional 3,3 V 

• Memiliki 11 pin digital IO termasuk didalamnya spesial pin   

 untuk fungsi i2c, one-wire, PWM, SPI, interrupt 

• Memiliki 1 pin analog input atau ADC 

• Berbasis micro USB untuk fungsi pemrogramannya 

• Memory flash : 4Mbyte 

• Dimensi module : 34,2 mm x 25,6 mm 

• Clock speed : 80MHz 

• Menggunakan IC CH340G untuk komunikasinya 

 Program untuk   memprogram   Wemos   sama   halnya   dengan   memprogram   

arduino   yaitu menggunakan  Arduino  IDE,  sebelum  memasukkan  program  ke  

dalam  wemos  terlebih dahulu  untuk melakukan install hardware  package untuk  

ESP8266  melalui board manager yang  tersedia  pada  Arduino  IDE  yaitu  dengan  

cara  buka  Arduino  IDE kemudian masuk menu File -> Preference 
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Tabel 2 2.2 GPIO Wemos D1 mini 

On board name Wemos D1 mini 

D0 GPIO 16 

D1 GPIO 5 

D2 GPIO 4 

D3 GPIO 0 

D4 GPIO 2 

D5 GPIO 14 

D6 GPIO 12 

D7 GPIO 13 

D8 GPIO 15 

 

2.2.5 Software IDE Arduino 

 Sofware yang digunakan yaitu software IDE arduino, Integrated 

Developtment Enviroenment (IDE) yang biasa digunakan untuk pengembangan. 

Disebut sebagai lingkungan karena melalau software inilah arduino di lakukan 

pemrograman atau melakukan fungsi yang dibenamkan melalui sintakx 

pemrograman. Arduino memiliki bahasa sendiri yang menyerupai bahas 

pemrograman C, bahasa arduino sudah mengalami perubahan untuk mempermudah 

para pengambang yang masih pemula dalam melakukan pemrograman dari bahasa 
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aslinya. Dapat menulis sketch, memeriksa apakah terdapat kesalahan atau tidak di 

sketch kemufian mengunggah sketch yang sudah terkompilasi ke papan arduino. 

IDE Arduino terdiri dari: 

• Editor program, sebuah window yang memungkinkan pengguna 

menulis dan mengedit program dalam bahasa prosessing 

• Compiler, sebuah modul yang mengubah kode program menjadi 

kode biner. Sebuah mikrokontroller tidak bisa memahami bahasa 

prosessing yang bisa dipahami oleh mikrokontroller adalah kode biner. 

Itulah sebabnya perlu digunakan kompiler. 

• Uploader, sebuah modul yang memuat kode biner dari komputer 

ke dalam memory didalam mikrokontroller Wemos D1 

 

Gambar32.3 Software IDE Arduino 
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Berikut ini adalah fungsi dari tombol-tombol toolbar pada IDE Arduino : 

    Verify 

Icon untuk melakukan perintah pengecekan error pada pada penulisan source code 

program. 

 

     Upload 

Icon untuk melakukan perintah meng-compile atau meng-upload program ke 

Wemos D1 mini board. 

 

        New 

Icon untuk melakukan perintah menuliskan source code program baru. 

 

         Open 

Icon untuk melakukan perintah menampilkan sebuah menu dari seluruh 

sketch yang berada di dalam sketchbook. 

 

 Save 

Icon untuk melakukan perintah menyimpan sketchpada penyimpanan local. 

 

 Serial Monitor  

Icon untuk melakukan perintah membuka windows serial monitor. 

 Sebelum meng-upload program, perlu mensetting jenis board dan port serial 
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yang sedang digunakan melalaui menu tool > Board dan Tools > SerialPort. 

Pemulihan board berguna untuk mengesat parameter. Setelah itu memilih board dan 

pot serial yang tepat, tekan tombol upload. Pada toolbar atau menu File > Upload. 

Arduino nano akan mereset secara otomatis dan proses upload akan dimulai jika 

berhasil maka tidak ada tanda tulisan eror pada bagian bawah dari Arduino IDE, 

saat program dpat berjalan maka yang akan muncul pada bagian bawah Arduino 

IDE adalah program sukses dan tulisan berwarna putih.  

 

2.2.6 Buzzer 

 Buzzer adalah sebuah komponen elektronika yang berfungsi untuk mengubah 

getaran listrik menjadi getaran suara. Pada dasarnya prinsip kerjanya buzzer hampir 

sama dengan loudspeaker, jadi buzer juga terdiri dari kumparan yang terpasang 

pada diafragma dan kemudian kumparan tersebut dialiri arus sehingga menjadi 

elektromagneti, kumparan tadi akan tertarik ke dalam atau keluar, tergantung arah 

arus dan polaritas magnetnya, karena kumparan dipasang pada diafragma maka 

setiap gerakan kumparan akan menggerakan diafragma secara bolak – balik 

sehingga membuat udara bergetar yang akan menghasilkan suara.  
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Gambar42.4 Buzzer 

 

Buzzer biasa digunakan sebagai indikator bahwa proses telah selesai atau terjadi 

kesalahan pada sebuah alat (alarm).[2] 

 

2.2.7 Sensor MPX5700AP 

 Sensor MPX5700AP adalah port tunggal, mutlak silikon sensor tekanan 

terintegrasi dalam paket SIP 6 pin yang merupakan sei Manifold Absolute Pressure 

(MAP) yaitu sensor tekanan yang dapat membaca tekanan udara dalam suatu 

manifold. Sensor MPX5700AP dilengkapi oleh rangkaian pengkondisian sinyal 

dan temperatur kalibator. Pengolahan bipolar di dalam transistor memberikan 

tingkat analog sinyal output yang akurat dan tinggi yang sebanding dengan tekanan 

diterapkan, sehingga MPX5700AP memiliki 2,5% kesalahan maksimum lebih dari 

0 C hingga 85 C, tekanan berkisar dari 15Kpa ke 700Kpa, pasokan rentang tegangan 

dari 4,75VDC ke 5,25VDC, sensitivitas 1.0 Kpa (Kilopascal) setara dengan psi, dan 

operasi rentang suhu dari -40 C sampai 125 C. 
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Gambar52.5 MPX5700AP  

 Sensor ini digunakan untuk mengetahui tekanan udara dalam sebuah benda, 

baik itu dalam botol, di dalam ban, dan lainya, sensor ini bisa mengukur dengan 

range 0 to 700 Kpa (0 to 101.5 psi) – 15 to 700 Kpa (2.18 to 101.5 psi), serta 

tegangan outputnya benda di range 0.2 to 4.7 volt.[7] 

2.2.8 Wifi 

 Wi-Fi adalah salah satu standar Wireless Networking tanpa kabel, hanya 

dengan komponen yang sesuai dapat terkoneksi ke jaringan. (Priyambodo,2005) 

Wi-Fi merupakan singkatan dari Wireless Fidelity yaitu sebuah penghantar 

komunikasi data tanpa kabel yang bisa digunakan untuk komunikasi atau 

mentransfer data dengan kemampuan yang sangat cepat. Wi-Fi juga dapat 

diartikan teknologi yang memanfaatkan peralatan elektronik untuk bertukar data 

dengan menggunakan gelombang radio (nirkabel) melalui sebuah jaringan 

komputer, termasuk koneksi internet berkecepatan tinggi.[8] 
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 Wi–Fi (Wireless Fidelity) merupakan pengembangan dari Hi–Fi, sebuah 

teknologi jaringan nirkabel yang digunakan diseluruh dunia. Wi-Fi Mengacu pada 

sistem yang menggunakan standar 802.11, yang dikembangkan oleh Institute of 

Electrical and Electronics Engineres (IEEE) dan dirilis pada tahun 1997 

(Rumalutur, 2014). Awalnya Wi-Fi ditunjukan untuk pengunaan perangkat nirkabel 

dan Jaringan Area Lokal (LAN), namun saat ini lebih banyak digunakan untuk 

mengakses internet. Secara singkat cara kerja dari Wi-Fi pada komputer yaitu 

wireless LAN yang telah di konfigurasi sehingga menjadi Wi-Fi akan menerima 

data dari komputer yang berbentuk digital. Selanjutnya data tersebut akan dirubah 

menjadi sinyal radio lalu dikirimkan ke router, pengiriman gelombang ini melalui 

antena yang ada pada adaptor. Dan sinyal dari router akan mengirimkan data yang 

telah di olah dari internet ke komputer yang sudah tersambungkan dengan Wi-Fi 

adaptor.[9] 

 Wi–Fi merupakan kependekan dari Wireless Fidelity, yang memiliki 

pengertian yaitu sekumpulan standar yang digunakan untuk jaringan lokal nirkabel 

(Wireless Local Area Network – WLAN) yang di dasari pada spesifikasi IEEE 

802.11. Standar terbaru dari spesifikasi 802.11 a atau b, seperti 802.11 g, saat ini 

sedang dalam penyusunan, spesifikasi terbaru tersebut menawarkan banyak 

peningkatan mulai dari luas cakupan yang lebih jauh hingga kecepatan transfernya. 

 

 

 Awalnya Wi–Fi ditujukan untuk penggunaan perangkat nirkabel dan jaringan 
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Area Lokal (LAN), namun saat ini lebih banyak digunakan untuk mengakses 

internet. Hal ini memungkinkan seseorang dengan komputer dengan kartu nirkabel 

(Wireless Card) atau personal digital assistant (PDA) untuk terhubung dengan 

internet dengan menggunakan titik akses (atau dikenla Hot Spot) terdekat. 

 IEEE 802.11a adalah sebuah teknologi jaringan nirkabel yang merupakan 

pengembangan lebih lanjut dari standar IEEE 802.11 yang asli, namun bekerja pada 

bandwith 5.8 GHz dengan kecepatan maksimum hingga 54 Mb/s. Metode transmisi 

yang digunakan adalah Orthogonal Frequency Division Multiplexing (OFDM), 

yang mengizinkan pentransmisian data secara pararel di dalam sub – frekuensi. 

Penggunaan OFDM memiliki keunggulan resistansi terhadap interferensi dengan 

gelombang lain, dan tentunya peningkatan throughput. Standar ini selesai 

diratifikasi pada tahun 1999. 

 IEEE 802.11b merupakan pengembangan dari standar IEEE 802.11 yang asli 

yang bertujuan untuk meningkatkan kecepatan hingga 5,5 Mb/s atau 11 Mb/s tapi 

tetap menggunakan fekuensi 2,45 GHz. Dikenal juga dengan IEEE 802.11 HR. 

Pada prakteknya, kecepatan maksimum yang dapat diraih oleh standar IEEE 

802.11b mencapai 5,9 Mb/s pada protokol TCP, dan 7.1 Mb/s pada protokol UDP. 

Metode transmisi yang digunakan adalah DSSS. 

 IEEE 802.11g adalah sebuah standar jaringan nirkabel yang bekerja pada 

frekuensi 2,45 GHz dan menggunakan metode modulasi OFDM. 802.11g yang di 

publikasikan pada bulan juni 2003 mampu mencapai kecepatan hingga 54 Mb/s 

pada pita frekuensi 2,45 GHz, sama seperti halnya IEEE 802.11 bisa dan IEEE 

802.11b. Standar ini menggunakan modulasi sinyal OFDM, sehingga lebih resistan 
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terhadap interferensi dari gelombang lainya. 

 802.11n merupakan perubahan terbaru yang mengembangkan 802.11 

sebelumnya dengan menambahkan MIMO (Multiple Input Multiple Output) dan 

beberapa fitur lainya. IEEE telah menyetujui dan telah diluncurkan dan di 

publikasikan pada oktober 2009. Dengan munculnya 802.11n telah disetujui pula 

oleh para produsen perangkat yang mendukung teknologi ini. 

 802.11n bekerja pada dua tipe frekuensi, yaitu 2,4 dan 5 GHz. Jika 

dibandingkan dengan versi sebelumnya yaitu 802.11g, yang memiliki raw data 

sebesar 54Mbit/s maka ada kenaikan yang sangat signifikan pada 802.11n. 802.11n 

dapat menembus raw data rate hingga 600Mbit/s dengan lebar channel 40 MHz. 

 Wi–Fi 802.11ac adalah standar nirkabel 802.11 yang saat ini sedang 

dikembangkan yang akan memberikan throughput yang sangat tinggi pada Wireless 

Local Area (WLAN) dengan frekuensi operasi dibawah 6 GHz (Lazim dikenal 

sebagai band 5GHz).[7] 

 Berikut ini beberapa fungsi dari Wi-Fi: 

• Koneksi ke jaringan internet 

• Kecepatan yang lebih baik 

• Sharing file 

• Sinkronisasi telpon tanpa USB 

• Menjadikan handphone sebagai modem 

• Sebagai router nirkabel 

• Sebagai pengaman 

• Streaming film ke TV 
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 Adapun beberapa manfaat yang bisa didapatkan dari Wi-Fi misalnya seperti: 

• Aksesbilitas 

• Mobilitas 

• Produktivitas 

• Distribusi  

2.2.9 Smartphone Android 

 Smartphone adalah telepon genggam yang mempunyai kemampuan dengan 

penggunaan yang mudah dan fungsi yang menyerupai komputer yang menyajikan 

filter dan spesifikasi yang canggih seperti internet, email, kemampuan membaca 

dan mengedit file – file dokumen, touchscreen, high pixel camera, big size memory, 

dan sebagainya. Dengan kata lain, ponsel cerdas merupakan komputer kecil yang 

mempunyai kemampuan untuk berkomunikasi. Sistem operasi yang dapat 

ditemukan di smartphone adalah iOS, Symbian, Windows Mobile, Linux, 

Blackberry, dan Android. 

 Android adalah sistem operasi berbasis Linux yang dipermudahkan khusus 

untuk smartphone. Karena sifatnya open source pengguna Android juga diberi 

kebebasan untuk menciptakan aplikasi mereka sendiri. Untuk saat ini distributor 

Android terdapat dua jenis. Pertama dari Google Mail Service (GMS), dan Open 

Headset Distributor (OHD). Distributor yang benar – benar bebas karena tanpa 

dukungan langsung dari Google. 

 Kelebihan smartphone Android: 

• Sistem Operasi bersifat open source. 

• Dari segi tampilan, terlihat elegant, sehingga pengunanya tidak  akan 
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mudah bosan. 

• Kemudahan mengganti tampilan atau tema jika kita bosan dengan 

 tampilan yang disajikan oleh produsen, hanya dengan 

 mendownload di market android. 

• Bersifat Multitasking yang artinya bisa menjalankan berbagai 

 aplikasi sekaligus. 

• Banyak aplikasi baik software maupun game yang bisa kita 

 nikmati mulai dari yang berbayar sampai gratis. 

• Widget, yang berfungsi untuk mempermudah penggunanya dalam 

 melakukan setting atau memilih aplikasi yang akan dijalankan. 

• Sinkronisasi, kita dapat mengintegrasi Gmail ataupun Tmail 

 dengan smartphone, sehingga akan mempermudah mengecak atau 

 mengirim email. 

• Kemudahan dalam notifikasi, setiap mendapatkan miscall, SMS, 

 chat baru baik dari ym maupun Facebook, Email akan selalu ada 

 notifikasi. 

 

 Kelemahann smartphone Android : 

• Akan terlihat sulit jika baru pertama kali mengoperasikan  smartphone 

Android, karena sangat berbeda sekali dengan  handphone – handphone 

lain. 

• Karena fitur multitasking menyebabkan smartphone android ini  sangat 

boros dalam pengunaan baterai. 
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• Koneksi internet yang mahal, pada saat browsing memang cepat 

 dan tidak ada hambatan, namun biaya untuk internet pun juga  sesuai 

dengan kecepatan tersebut. 

• Jika menggunakan aplikasi tertentu, iklan akan selalu muncul pada 

 aplikasi tersebut tetapi munculnya iklan hanya pada saat  smartphone 

terhubung ke internet. 

2.2.10 App Inventor 

 App Inventor adalah sebuah Web Aplikasi yang di kembangkan oleh Google 

dan di rilis pada 15 Desember 2010, pada awalnya penelitian ini dilakukan oleh 

google dengan tujuan sebagai kompetensi pendidikan pada lingkungan oleh google 

dengan tujuan sebagai kompetensi pendidikan pada lingkungan pengembangan 

online, App Inventore berbentuk Web Aplikasi yang di gunakan untuk 

mengembangkan atau membuat aplikasi android phone. Bahasa pemrograman 

secara keseluruhan dan tanpa coding sama sekali, karena App Inventor ini hanya 

drag and drop. App Inventor adalah sebuah aplikasi builder untuk membuat aplikasi 

yang berjalan di sistem operasi android yang disediakan oleh google labs dan untuk 

membuat aplikasi android harus bermodalkan koneksi internet dan browser. Desain 

yang di buat akan di simpan secara online yang membantu kita untuk mengerjakan 

proyek ini secara bertahap. App Inventor ini menggunakan teknik visual 

programming, berbentuk seperti susunan puzzle – puzzle yang memiliki logika 

tertentu. 

 


